VI r9xz7&L0a0T74F2L—o
>

ZOFETIE, CiscoASA Y 7 b =27 BLIRar 74X 2 b—ya OFEHGEICHOWTHBA
LET,
VT MU T DT T T L—K (1X—=Y)
* ROMMON Z i L7zA A=Y Dr—FK (1 3—=)
*ROMMON A A=Y D7 w77 L— K (ASA 5506-X, 5508-X. FLU5516-X) (53—
V)
¢ ASAS506W-X VA YL AT IV ERARL LV FOAA=YOREBLOn—F (64—)
VT NI T DR LT L — K (7T4—=2)
c 77 ANDEH (9 =)
*ASA A A— ASDM, BXUOAX— KT v 7 a7 4 Falb—raOFE (18—
V)
e 7 4 X2l —arERIFFOMO T ANDNNy 7T v T BIOET 20°2—)
« VAT AEHEBIOR Y 2 —L (25 2—2)
* Auto Update D% E (26 ~<—)
eV T7 Ny T Ear 7 4 Fal—aryDEE (33 2—)

YOI T7OT7vITTL—FK

SERIRT v 7 L— ROFNEIZOWTIL,  [Cisco ASA Upgrade Guide] ZZ&M L T 72& 0,

ROMMON Z{ERA L=/ A—>DA—F

ROMMON ZfEH LT, HriLWA A—Tha— R TExFET,

YIrwz7ssUavIqFaL—var |


https://www.cisco.com/c/en/us/td/docs/security/asa/migration/upgrade/upgrade.html
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B rommoN %M L1- ASAS500-X & U — DA A —DDE— K

ROMMON % L 7= ASA5500-X > !) —XDA A—IDBE— k

ATy
ATy T2
ATvT3

ATy T4

ATy TH

ATvT6

TFTP Zfi1 L T ROMMON E— R225 ASA ~YV 7 " =7 A A—V % — RT3 51203, &’
DOFNEEFITLE T,

FIE

TTIAT VA A= ~DT I B AT, ASAD =V —)L R R— ML E7,
ASA ODEJRZY > Thro, FEREAIZLET,

AL =7 v 7DOMIZ, ROMMON £— FIZAL X917 m 7 MRS 5, Escape % —

ROMMON £— KT, IP7 LA, TFTP YV — X7 KL A, #F—hU=xAf T RLA, YTk
VT A A=Y T7A, BELOKR—r2Ete, ASAIZKTEHA X —T A AREEZIRD
XolCERLET,

rommon #1> interface gigabitethernet0/0
rommon #2> address 10.86.118.4

rommon #3> server 10.86.118.21

rommon #4> gateway 10.86.118.21

rommon #5> file asa96l-smp-k8.bin

() vy NI ~OEGP T CIHAET DI &R LTSN,

AB—T 4R a2~ FiLASA 5506-X, ASA 5508-X, BLUNASAS5516-X 77
N7 —ATHEHEINDTZD, ZNHDT T > 74— T Management 1/1 1 % —
T = A AD TFTP U N ZFETT 20N H D £,

RIEEMRAEL £

rommon #6> set

ROMMON Variable Settings:
ADDRESS=10.86.118.3
SERVER=10.86.118.21
GATEWAY=10.86.118.21
PORT=GigabitEthernet0/0
VLAN=untagged
IMAGE=asa961l-smp-k8.bin
CONFIG=
LINKTIMEOUT=20
PKTTIMEOUT=4
RETRY=20

TFTP ¥ —/IZ ping Z %5 L £,

rommon #7> ping server
Sending 20, 100-byte ICMP Echoes to server 10.86.118.21, timeout is 4 seconds:

Success rate is 100 percent (20/20)
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ATy 717

ATvT8

ATvT9

ROMMON %fF L 7= AsasM 1 2 —saa—F [

Ay NI —VREL, BTHMTEDLLIITRE L TRBEET,

rommon #8> sync
Updating NVRAM Parameters...

VAT YT I 2T A A=V Er—RNLET,

rommon #9> tftpdnld
ROMMON Variable Settings:
ADDRESS=10.86.118.3
SERVER=10.86.118.21
GATEWAY=10.86.118.21
PORT=GigabitEthernet0/0
VLAN=untagged
IMAGE=asa961l-smp-k8.bin
CONFIG=
LINKTIMEOUT=20
PKTTIMEOUT=4
RETRY=20

tftp asa96l-smp-k8.bin@10.86.118.21 via 10.86.118.21
Received 14450688 bytes

Launching TFTP Image...
Cisco ASA Security Appliance admin loader (3.0) #0: Mon Mar 5 16:00:07 MST 2016

Loading...

VTR T A A=VUNREFICe—REND &, ASA IZHEIIIIC ROMMON £— F&H#& T L
ij—o

ROMMON E— F235 ASA ZEENT A5G, VAT L A A—213V v— RETHRE S ARWND
72O, REFVAA—TET T a ARV IIA U a—RTEMNERSDET, Y7 b7
DOT v T T L—F (1=3) 28R LTIIEEN,

ROMMON Z{EA L 7= ASASM DA A —2 D AO— k

ATy

ATy T2
ATvT3

TFTP % 1] L T ROMMON E— FinH ASASM ~Y 7 h U =7 A A=V &k u— FT 520,
ROFNEZEFATLET,

FIE

ASAYV—ERETVa—)LarV—)L~DT T RIS T, ASAD Y —)Lik— NI
LET,
ASASM A A—U% U r—RFT5Z L AR LTI EIN,

2B — T v 7DORIZ, ROMMONE— RIZAD K HiZ7 e 7 FRRESNZ S, Escape ¥ —
EFLET,

YIrwz7ssUavIqFaL—var |
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B rommon £ L ASASM 04 X —SDn— K

ATy 784 ROMMON E— RT, IP7 RV A, TFTPH— "7 KL A = T 7 RL A, Y7k

ATy Th

ATvT6

ATy 71

VT A A=Y T A, R—FBIURVLAN #5¢r, ASASMIZXT B A Z—T = A A
BEERDLIICERLET,

rommon #2> address 10.86.118.4
rommon #3> server 10.86.118.21
rommon #4> gateway 10.86.118.21
rommon #5> file asa96l-smp-k8.bin
rommon #5> interface Datal

rommon #6> vlan 1

Data0

Link is UP

MAC Address: 0012.d949.15b8

GE) Ry NUT—I ~OEEGENT TICHEET A E 2R LT IEEN,
REEBIELET,

rommon #7> set

ROMMON Variable Settings:
ADDRESS=10.86.118.4
SERVER=10.86.118.21
GATEWAY=10.86.118.21
PORT=Datal
VLAN=1
IMAGE=asa961-smp-k8.bin
CONFIG=
LINKTIMEOUT=20
PKTTIMEQOUT=2
RETRY=20

TFTP H— /3 ping #3155 L £ 7,

rommon #8> ping server
Sending 20, 100-byte ICMP Echoes to server 10.86.118.21, timeout is 2 seconds:

Success rate is 100 percent (20/20)

VATA YT 2T A A=V Ea—RLET,

rommon #9> tftpdnld
Clearing EOBC receive queue
cmostime set = 1
ROMMON Variable Settings:
ADDRESS=10.86.118.3
SERVER=10.86.118.21
GATEWAY=10.86.118.21
PORT=DataOl
VLAN=1
IMAGE=asa961l-smp-k8.bin
CONFIG=
LINKTIMEOUT=20
PKTTIMEOUT=4
RETRY=20
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| voroz7s&tarrqFarL—vay

ROMMON A A—S D7 v 45 L—F (ASA5506-X. 5508-X. &5 & U 5516-X) .

tftp asa96l-smp-k8.bin@10.86.118.21 via 10.86.118.21
Starting download. Press ESC to abort.

VTP T A A=UNREFIZe—REN5D L, ASASM iT HE1HYIZ ROMMON £— K& #& T
L/ji‘g_o

AT Y78 ROMMONE— R BEY 2 — VA RET 56, VAT A A A=) n— RETHREES R

RN, RIIVAA—TE T Ty va AFVIA Y a—RTH3MLERBDES, VY7 b
D27 DT v T —F (1X=) ZBRLTLIEEN,

ROMMON 4 A—S M7 w745 L— K (ASA5506-X.
5508-X. & & U 5516-X)

&

ATy T2

ATvT3

ASA 5506-X U — X ASA 5508-X. 35 L TF ASA 5516-X ® ROMMON A A —V%7 v 77
L— FT51013, ROFIEICHENET, AT A0 ROMMON /A— = 43 1.1.8 LR TR
nE7e v A,

188 BRI

=g ~DT v T T — ROBRARETT, XU 71— REITEERA, BEDN—
Va rEMERT 5121, showmodule 2~ K& AJJ LT, MACT KU AHFHT—7 /L ® Mod
1 OHESITCFw A=V a U EFERET,

ciscoasa# show module

[...]

Mod MAC Address Range Hw Version Fw Version Sw Version
1 7426.aceb.ccea to 7426.aceb.ccf2 0.3 1.1.5 9.4 (1)
sfr 7426.aceb.cce9 to 7426.aceb.cce9 N/A N/A
F&E

Cisco.com 2* 58 LV ROMMON A A —T#E&E LT, = NEIZEWTASAIZaE—LFE
3, ZOFIETIZ, TFTP 2 ©°—D HEEZFHA L E9,

WO URLINHA A=Y EX T rm—RLET,
https://software.cisco.com/download/type.htm1?mdfid=286283326& flowid=77251

ROMMON A A =% ASA 7 7 v a A VICat—LET,
copy tftp://server_ip/asaS500-firmware-xxxx.SPA disk0:asa5500-firmware-xxxx.SPA

ROMMON £ A=V %27 v 77 L —RKLET,

upgrade rommon disk0:asa5500-firmware-xxxx.SPA

YIrwz7ssUavIqFaL—var |


https://software.cisco.com/download/type.html?mdfid=286283326&flowid=77251

YIrYITELVIYTaFaL—2ar |
B Asassoswx 74 v LR 7o ER KA L hOA A—COEBES LUK

1 :

ciscoasa# upgrade rommon diskO:asa5500-firmware-1108.SPA
Verifying file integrity of disk0:/asa5500-firmware-1108.SPA

Computed Hash SHA2: d824bdeeceel308fc64427367fa559%e9
eefeB8f182491652ee4c05e6e751f7a4f
5cdea28540cf60acde3ab9b65f£55a9f
4e0cfb84b9e2317a856580576612f4af

Embedded Hash SHA2: d824bdeeceel308fc64427367fa559%e9
eefe8f182491652ee4c05e6e751f7a4f
5cdea28540cf60acde3ab9b65f£55a9f
4e0cfb84b9e2317a856580576612f4af

Digital signature successfully validated

File Name : disk0:/asa5500-firmware-1108.SPA
Image type : Release
Signer Information
Common Name : abraxas
Organization Unit : NCS_Kenton ASA
Organization Name : CiscoSystems
Certificate Serial Number : 553156F4
Hash Algorithm : SHA2 512
Signature Algorithm : 2048-bit RSA
Key Version : A

Verification successful.
Proceed with reload? [confirm]

ATFyTd T ERFRENTED, HHELTASAZVe—RFLET,
ASA X’ ROMMON A A — %27 w77 L —RL7#%, ASADOSZ Y u—RLET,

ASAS506W-X JA XY LA T7IEARKRA DA A—D
EEELUTA—F

TFTP #ffH L CY 7 b =7 A A—T%[E1E LT ASA 5506W-X I 2 — KT 5121, IROTF
g A 31T LE T,

FIE
AT TN 778A KL (AP) ~DE v 3 % L, APROMMON (ASA ROMMON TCi7a

<) ZRmLET,

ciscoasa# hw-module module wlan recover image
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AT w72 CiscoAironet 77 ZARA L b CiscolOS V7 b =7 a7 4 FXalb—ar HA R [HiE]
DFMUZGENET,

VIR T7DEOTL—Fk

AU 7= RTE, DFOKRELZZE T 57200y a— 1y MBFELET,
e T —h A A=V ar 7 4 Xa2l—320D27 YT (clear configure boot) .
s VWA A—=TADT =k 4 A=V DFKIE (boot system)
s (AT vay) BT 7T 4= 3 F—DAJ (activation-key) .

cFITAL T 4 X2l —Ta DAL — T v T ~ORSF (writememory) , ZAULZ XD |
BOOTBRIEAH A fT A A—VICRELET, 072, Ver—RT5ELHng 2—T0n
n— RENET,

CARX— R NT T ar74FXal—ar~Ohnar7 s ¥alb—aryoat— (copy
old_config_url startup-config) .,

ey — K (reload) .

4R8O HREIIC

e I TGAF N U THOAXDOEa XA L X0 T L— ROV R—MNMIHY ETHA,

EELBAICE-TE, B Ao A A XU T — R BELE T, ¥ T L—
RIZBT 2R OB OREZ SR L T &V, ZOMORENREKNTY I AX 2=y b
DY Ba— RKBRREZDHZ 0D, TOHRFITX T ZA LB ELET,

A=K FABLADIIO)DEDE T T L — R A —h T—Vx NOEH
W2k, ¥or 7 r— RT 585137 7314 A% Cisco Smart Software Manager (Z FJ %%
BT AMENRBY ET, FTLWA~Y—bh=—Txr NCIEE(LINTE T 7 A L5 1f
MT 5720, BEELTHWAY—F=—Vxy N TRERBEE (LI T RN T 7
ANEERTLILENDY £,

IV TAXN T EERIIN) LVEIOV U—A~DHE T 7 L— K 1 99(1) LA TIL,
Ny 7Ty TORMPUESNTNET, 7 TFAXICIDL D=y "3H D55
X, WOFNEZFATTHHERNH Y £7,

. ZIRENBT_XTOEh Y 2=y b2HlfRLEST (VT AXETT T4~V
2=y hOATHERESNET) .

2. 12O hHY o=y "2 X T 7L —RL, ZIAZIZHESMEEE T,

3. 7945V 2=y hCOTRZY T HEBENILET, TOa=y FEX TS
L—FRL, Z77RAZIZHZMSEET,

YIrwz7ssUavIqFaL—var |


http://www.cisco.com/c/en/us/td/docs/wireless/access_point/12-4-25d-JA/Configuration/guide/cg_12_4_25d_JA/scg12-4-25d-JA-chap22-trouble.html#wp1048378

YIrYITELVIYTaFaL—2ar |
B oroz7089050—¢

4, OO I F) a=y XU T L —KRKL, ZnbE—EIZ1OoTD7 TR
ZICHEBIMEEET,

« 7T AL YA NOTLEMEZAENCT 2561, 99 LVETiOY V—R Xy 7
L—RLET, ¥V 7L —RT256 (F72139901) KV RiD2=y N7 T A
BT 25E) 1%, A NOILEREZINCT 20ERNHY £9, £ LRNE,
HDWN—=T g UEFATL TS =y MIX I —DRET v —72 EORIWERNREAEL
3

e VTRV U T BRI SY y TEEHT HGEICI8W) X T T L — RT 5
B~y TREESNTHDAEARIZIS) LA T T L—RT5E, Er ¥y
A LT T L—RFIVFR—FEhEtA, XU 7 L— RECHE~Y Yy TRESR
JUVT L, FUr7Lb—RRICKEZD O —EHEHTOILERS Y 7,

eV TARY T 2=y FONVAF = v 7 % 0.3 ~ 0.7 IR E L7 IRRET 9.8(1) 2

X7 L— K95 : (health-check holdtime T) 7—/ L RHf[H] % 0.3 ~ 0.7 FHITFR
FELFEBETASA Y 7 b =T 2 F 70 7L —RT58 . BrILLREITVR—FENn
RN BREMEIXT 7 AV O3 FITREY £,

« 7T AK Y T (CSCuv82933) ZfliH L TV DHE129.5(2) LARED 5 9.5(1) LARTIZ &
U= RTD 950 b UL —RTAGA, Y X o r AL LTS
L— RV FR—FrENERA, 22y MRFUTA VRS TZEEITH LW T AKX
DIEREIND LI, T_XTO2=y FEIFFERFHZY 2 — FT 50 ER"H Y £,
2=y FBIEFICY B — RENDLDEFOE, 7 TAZEERTE LD 7,

« VAR T EMHAT HEEIT92(1) LIEND 91 BEHCH v v 7 L— KR35 &
0 XU EAL L FT T L— RiIR— S EE A,

* PBKDF2 (/RAT— R R—2Z2DF—JRAEMEK2) Ny a2z AU — RCTHEATIHAEIC
95 LIHIDN—=V a NIHX T T L —RT5 : 9.6 L VRETO/N—2 3 U IPBKDF2 /Ny & =
ZHAR— R LTWEREA, 9.6(1) TiE, 32 XF XY EV enable /N A U — KI5 1 (N username
NXAT— RCTPBKDR2 v v =aZfEHLET, 9.7(1) TlE, 3 _XTOHLVWIAT— K
I, BESICEHDLT PBKDR2 Ny v aZHLET BEFO/NRA T — RiE5 & E MDS
Ny vaRfALET) , XU L — K95 &, enable /NAU— K3 F 7 4L b (2
A) IRV £9, 2—FHIFIE LTI T, username 2~ RAHIBRSNLET, v—
NN 2—F b ) —EERT DMNENRH Y 7,

ASAV D /R—2 9 2795022000 b DX 7 7 L— K 1 ASAVIE T A & 2 A BERIRRE & {7
FfL £t A, license smart register idtoken id_token force ==~ > N CTHEERT 2 MR H 0
¥ 9 (ASDM O34, [Configuration] > [Device Management] > [Licensing] > [Smart Licensing]
~— T [Force registration] 47> 2 % fi[ll) , Smart Software Manager 725 ID h— 7 >/
2R LET,

REEBITTHE, XU T L— RORKICEEE 52 D EERHY £7, TDH,
A7 L— R CTE A WVERED RNy 7 7T v 7R T Z L 2R L ET, 83
~OT 77— RRIZE, Ny 77 v TR AEICER SV ET

(<old version> startup cfg.sav) , OBITTIE ANy 7 7 v 7BIER SN ERF A, T I—
VarTIIRIHTER P ST aw RBRHILLERTEBICEEN TS E, BRENRR— RS
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ATvT1

ATy T2

ATvT3

ATy T4
ATy TH

ATvT6

sr1rnez |

meXiENLOavry RO —REREINET, 2L, =7 —FEBHETEET, &
NR—= 3 VOREDBITEITEIEOFEMC AW, A X—Ta DT v 77— KA
A4 REZHL TN,

c JED h RN F I T— N LK F AL — R e R— R L72WY 7 Ry =T "=V 3
T AR UNATEBENFEIT L TODEATH, VPN b U RV R A X A 3 C R S E
T, ZOVFUAE, XU L— RERCRE L9, LA, VPNER 2 U L CH
B LT EEW,

FIE

[Tools] > [Downgrade Software] % 3R L 9,
[Downgrade Software] %A 7 12 7R v 7 ANERINET,

ASA A A —T DA [Select Image File] #7 U v 7 LE7,
[Browse File Locations] % A 7 12 7' 7R » 7 ANERSINET,
RKONTNDDOA T ar REEIY v 7 LET,

* [Remote Server] : K2 v 7*Z 7 U A KT [ftp]. [smb]. [http] DT IE IR L, LIA]
DAA—=Y T ANDNZAEASLET,

« [Flash File System] : [Browse Flash]| %27 UV v 7 LT, v—A)N 7T v a2 Ty A )V VAT
DZHDHLHEIDOA A=Y 77 A NVERIRL T,

[Configuration] C [Browse Flash] #27 U v 7 L, BATRIORE 7 7 A V&2 EIR L £,

UEE) RN—=Ta 83 LV bHIOT 7T 4 _X—vay F—IZRTHEIL, [Activation Key]
TA =N RTURIOT 7T 4= ar F—2 AN LET,
[Downgrade] &2 V v 7 LE7,

J271ILDOEHE

\}

ASDM (1, AW 7 7 A VEBX AT 2 FATT HOIE R 7 7 A VEBEY —L &y b
DHABEINTWET, 774/ NVEHEY—LCLD, 77y a2 AEVIRGESNTWND 7 7 A
NOFRR, BE), abv— BIOHIR, 7741 0k5%E, BIRVE—F A ML—Y 734
A (T RRAUD) DT 7 ANVDEREIT) ZENTEET,

G¥)

VAFALTXRAR T—ROYE, ZOY—VEV AT AOEF 2 YT 4 AT HFARNTE
FHERTEET

YIrwz7ssUavIqFaL—var |
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. T7ANT I EADRE

TJ74AIVTIOERADETE

ASA ClX. FTP 7 94 7> b, X% a7 at— 2547 b, X TFTP 2 5472 N4
EHTEET, F77. ASAZEFaT abt— P —NRELTHETHIELTEALAD, o
Pa— A TEXa? abt™— 75347 FEFEHTEET,

FIPV 547>k E—FDERE

ASATIE, FTIPH—REDH T, /1 A= T 7 AN T 4 X2l —al T7ANVDT v
Ta—RBIOF T — REFITTEET, Ny U7 FIPTIE. 7 747 & MIkliEEsks
FOFT — 2B OW FT 2B LET, RNy T = N TIET—ZEHROZ T ANAIE 72D —
Nt SEIOFRFEDERIZBWTY v ALV TAR— FEFEIGEL LTRLET,

FIE

AT 71 [Configuration] > [Device Management] > [Management Access] > [File Access] > [FTP Client] ~<A >~
. [Specify FTP mode as passive] = v 7 R v 7 A& 412 LET,

AT97T2 [Applyl 27 U v 7 LET,

FTP 7 9A T FDary 7 4 X2 b—a VBN ERSHh, FOERNENFETa L 74X
L—ya VIBRIEENVE T,

X127 aEF—H—/NELTOHASA DEFE
ASA ETEF 27 a— (SCP) V— %A R2—T/WIT&ET, SSHIZLD ASA~DT 7
CREHRINTZ I TAT 2 NETHD, BX=27 av—EaiE L TEET,
1R BHHIIZ

e —NIZIFET 4L N B R— BBV EEA, T4 L7 B HER—=INRRNTZ0H, ASA
DOWNEBT 7 AN~DYFT—F 77T b T 7 BRIHBPENET,
o b —RTlX, NS —FHF VANV =B R—=FINTWET A,

e« ASDM. Telnet, F7-1LSSHHD ASA 7 7 B RADEE IZH-> T, ASA TSSH ZHNZ L
e

¢ SSH X— 3 V2 8 AR — 4 BI121E. ASA DT A & AT E 21k
(3DES/AES) T A & ANNETT,

R TESNTORDNED < F arTF AN = RKTIL, VAT LAFE[TAL—R
TROFIEAZETLET, FEVATL a7 4 Fal—3i gy F—RIZASTORND
%A . [Configuration] > [Device List] XA > C, 7277 4 TIRT /XA ADIPT KL ADTFI|Z
H % [System| X T NT Y w7 LET,
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cEFaT a—ORT = AL, AT LORET AT XA DRRERFELE
9, T 74/ F T, ASA L 3des-cbc aes128-cbe aes192-cbe aes256-cbe aes128-ctr aes192-ctr
aes256-ctr DIEIZ T N T Y A bz x I —FLET, BRINEZEHOT LI Y X A
(3des-cbc) MBI EIT=HE . aes128-cbe 72 E D —J@hHRA 72T LT U X LANEFER I
ALV L KRIBICN T 4 —< U APMETFTLET, B INEHEFXE2ELET 5123
[Conﬁguration] > [Device Management] > [Advanced] > [SSH Ciphers| 1 > ZfEfH L £,
72 & 21X, [Custom] %R L T aes128-cbc IZF% T L £ 77,

FIE

ATYT1 avTHFART—=FRIZLoTRD L IITHERY 4,

o 7V E— RDOYE ., [Configuration] > [Device Management] > [Management Access] > [File
Access] > [Secure Copy (SCP)] DJEIZIEIR L £ 9,

« v /LF T— FOHE | [Configuration] > [Device Management] > [Device Administration] >
[Secure Copy] DINEIZEIR L £,

AT 72 [Enable secure copy server] = v 7 Ry 7 AeA I LET,

AT T3 (7T ar) ASA ITEERIEDS SCP — 3D SSH AR A b —ZHRFELE4, SLEST
T ASA T —HR=ANLFFHITH— N ZFOXF—2BMFEITHIBRETE FT,

F—ZBMNT DI, ROFIEEZFEITLET,
a) LW —D[Ad] 27 ) v 7T 50, EFRIHMEETEDLSSHAERA NOT—T A0 b
P—RERIR L, [Edit] 227V v 7 LET,

b) HLWH— D [Host] 7 4 —/L RIZ, =D IP 7 FLZ2Z AN LET,

¢) [Add public key for the trusted SSH host] = v 7 R v 7 A% A N2 LE T,

d) ROVWTIIOXF—%HELET,
e T4 H—=TV b TNy v aINTWDLXF—2 AN LET, 72& 21X, show
a<wy FOMINs ae—L7ed—T7,
« X — :SSHAARA MDAMF—FiF Ny 2z AN LEST, F— AN 73
E— h BT D Base6d THE(L S 72 RSAAHF—TCTF, =7 SSHZ 74 7> b
Mo (S0 2 5 & sshfid rsapub 7 7 A D) AR —EZEfG TX £9, Basetd
TRHEAL SN AT — 225 L2k, SHA256ICL > TEDOF =Ry v ZhE
7T

F—ZHIFRT 5121, B TE D SSHARA FOT—T b — " E 8 L, [Delete] % 27
Vo LET,

ATv T4 (FTvay) HLOARA =N &z & 2@ a2 T A 2%, [Inform me when a
new host key is detected] = v 7 R 7 A% A N LET,

FIFILIRT, ZOF T a AIBNR>TWET, ZOF > a v BAR—T I o>T
WAHEA. ASAICETERMENTWRNWERA M —2 A ERI3EST L 5RO bNE
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B asatFrPosc7 rosaBE

ATy TH

T, ZOF T arn T 4 =TI o TWAEE . ASAITBEICEEINT-Z LN NER
A b —% HBBICHFAT LE T,

[Applyl 27 U v 7 LET,

1

NHERANDT T4 T b, SCP 7 7 A WinkaFITLET, =& 2IE. Linux
TlHHERDOa~ FEATTLET,

scp -v -pw password source_filename username@asa_address: {disk0|disk1}:/dest filename

VIITEEZELET, -pw BIEESNTORWESIE, NAT—-KRKDANEZRD DT
oy EREREINET,

ASATFTIP Y SA 7> FDINRERTE

ATy T

ATy T2

ATvT3

ATy T4

ATy TH

TETP X, H#iZx 7 A4 72 MY — 77 A )Lk 71 b2/, RFC 783 1 L O RFC 1350
Rev.2 THESNTWET, TFTP — LD TT7 7 A VA2 a b —T&x 5 L 91T, ASA %
TFTP 7 A 7 hELTRETEET, ZHIZXKY, 207 4Falb—vary 77 A V%
Ny 7T o7 L, TNHEEED ASAIZT /87— T&EF£7,

Z 2T, TFTP H— "D RAZHFER TE H7280, copy 35 L UF configure net 72 £ D =1+
Y RCANT 2MENR 220 77,

FIE

[Configuration] > [Device Management] > [Management Access| > [File Access] > [TFTP Client]
DINAIZEIR L, [Enable] F = v 7Ry 7 A% A LET,

[Interface Name] K2 v 77X URA kv, TFTP 7 A4 7 b ELTHERAT A 4 —T7 =
A A& BN £7,

ar 74 Xal—rvary Ty ANVORFHEET D TFTP H— "D IP 7 R L A % [IP Address]
74—V RIZATILET,

AT 4 Xalb—ay Ty A NVORFEE T D TFTP —/ S ~D /XA % [Path] 7 4 —/L RIZ
AN LET,

f3 : /tftpboot/asa/config3

Apply 7 VU v 7 LET,

EAPZRZ b 5 A O EY) 1

CIFS~¥7 > h BAYVFEFIZFIP~ T2 h RA v FEBTE F4,
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crs <ok gq > roem [

CIFS Yo > kR4 > FDIEM

ATy T

ATy T2
ATvT3
ATvT4
b &AL
ATvT6
ATy T17
ATvT8
ATvT9

ATy 710

ATy 7N

@A H =R N T ANV AT A (CIFS) ~U v b ARA V MEERT DI, ROFIE
FEITLET,

FIE

[Configuration] > [Device Management] > [Management Access] > [File Access] > [Mount-Points]
DIEIZER L, [Add] > [CIFS Mount Point] DJEIZZ U v 7 LE,

[Add CIFS Mount Point] # A 7 12 77K » 7 ANERSINET,

[Enable mount point] = v 7 AR v 7 A% A NI L E T,
ZHIZED ., ASA FDOCIFS 77 A4V VAT AN UNIX D7 7 ALV V) —C8m S ET,

[Mount Point Name] 7 4 —/V K2, BEfED CIFS 2MFAET DALE D4R 2 AT L £,

[Server Name] 7 ¢ —/L RE 72IZ [IP Address] 7  —/V RIZ, ¥~V b RAV MERET LT —
NOLRTETALTP 7 RLAE AT LET,

[Share Name] 7 « —/V KiZ, CIFS % — LD 7 4V F D4R TEZ AT LET,
[NT Domain Name] 7 «# —/V RiZ, —IREHT B NT A A U O4Fi2 AN LET,

=N T DT 7 AN VAT LDV MBI TWD 22— D4RI%Z, [User Name]
T A=V RIZANLET,

=X T DT 7 AN VAT LD T Y NERA[SITNS—FD/RAT — K% [Password]
74—V RIZANILET,

[Confirm Password] 7 4 —/L R{Z/XAT— REZF A LET,
[OK1 %227 U v 7 LET,
[Add CIFS Mount Point] # A 7 1 7' /K v 7 ANFA L ET,

[Applyl 27 U v 27 LET,

FIPY Y b RA4 > FDEM

&

FTP~7 > b iRA v FDOEFA, FIP T — NI UNIX DT 4 L7 b U U R K AZ A )L NEE
T4, Microsoft FTP — 21X, T 74/ FTMS-DOST 4 L7 bJ URA KM ZFZANBHY
F9,

FIE

[Configuration] > [Device Management] > [Management Access| > [File Access] > [Mount-Points]|
DNEIZEIR L, [Add] > [FTP Mount Point] DJIHIZZ U v 27 LE T,

[Add FTP Mount Point] # A 7 &2 7R v 7 ANEREINET,
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B - regmv—n~o7stz

ATvT2

ATvT3

ATvT4

ATvT5

ATy T6
ATy T17

ATvT8
ATvT9

ATv 710

ATvIN

[Enable] F= v 7 Ry 7 AZEIRL T,
ZHUZEY . ASA FOFTP 77 AV AT AN UNIX D7 7 AV VU — 128k INFET,

[Mount Point Name] 7 « —/V RiZ, BEfED FTP BNFEIET HALE DL RITE2 AT L E T,

[Server Name] 7 4 —/V R E£ 721X [IP Address] 7 4 —/V RIZ, ¥~U > b RA v M eET L0 —
NOLRTEZIZIP T RLAZ AN LET,

[Mode] 7 4 —/V K C, A7+ a > R¥ > ([Active] £7-1% [Passive]) =7 U v 7 L CFTPE—
RZ@IRL £9, [Passive] E— REZRIRLT-HE. 7747 FTIL, FTP 2 b v — /L8
T HEEGNE BITEBI LET, N, ZOERE Y v AU T HR— FOFESTIEEL
£

FTP 7 7 A )b H—"~DF 4 L7 N Y /X244 % [Path to Mount] 7 4 —/L RIZAJI L E T,
=T DT 7 AN VAT LDV FERAI SN TND 22— O4 R[4, [User Name]
74—V RIZATILET,

P NHT D77 ANV AT LOY T FERBAISNTND2—FD/RAT — K% [Password]
74—V RIZATILET,

[Confirm Password] 7 4 —/L R{Z/XAT— REZF A LET,

[OK] %2 Vw27 LET,

[Add FTP Mount Point] # A 7 @ 7758 v 7 AR U £97,

[Applyl &7 U v 7 LET,

774 ILEEBY—ILADT7 71X

&

T ANVERY — VAT 5123 ROFIEZETLET,

FIE

AA Y ASDM 77U r— a3 7 42 KT, [Tools] > [File Management] DJIRIZER L &
hj‘o

[File Management] % 1A 7 2 778 v 7 ANERINET,
« [Folders] XA 12X, T4 A7 BICH D7+ VA NFRENET,
* [Flash Space] 1Z, 77 v =2 AEFVOFRFEREREL, EHMRERAEVRELZRLET,
o [Files] fEIICIE, BIRLIZT7 4L E DT 7 A MTONWTRDIGERNFREINET,
« 82
T AN
c PR (N B HILE)

« [EIERZ]
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T 74 ILDERE .

CBINLIT s ANDOEE (F—h a7 4 Xal—vary, T—h A A=V T7A
by ASDMA A—Y 77 A4, SVGCA A=Y 77 A, CSDA A=Y 77 AL, £
771X APCF A A — 77 A )V) ZgRd, AT —H A

ATvT2 BRUIET7ANET T UHICERTDHIIE, [View] 227 Vv 7 LET,

ATvT3 BRULEZ7ANVEGVES THOT 4 L7 S UICEEY AT 510, [CutlZ 27V v 7 LET,

ATy T4 BRLEZT77 AN Ea—LTHIOT o L7 FUIZAED T 5 I121E, [Copyl 227 U v LE
D

AT9TEs  abv—L7 7 A NVERR LGNS0 1 210X, [Paste] %27 U v LET,

ATYT6 BRLIET77ANET Ty a AEYNPOHIBRT 5121, [Delete] 227V v 27 LET,

AT9 Tl  TrANVDOLARIEEET ST, [Rename]l 27 U v 7 LET,

RATYT8 TrANERGETDHT 4 V7 N EHHMERT ST, [New Directory] %7 U v 7 LE7,

AT w79 [FileTransfer] ¥ 4 7 1 77K v 7 A% B < 21X, [FileTransfer] Z#7 V » 7 LE¥, #EMICONT
X 77400k (155—) | #BRLTIZEN,

AT 710 [ManagePoints] % 1 7 1 7R v 7 2B < 121X, [MountPoints] %27 U v 7 LE¥, FEMIZOW
T, T~or bARA U boBEM (125—=2) ] 2BRLTIEI,

771 IILDERE

File Transfer Y —/LiZ LV, a2 —hiZH b7 7 AN EVE— MNIHD T 7 A NVERETEF
T, PCERIFTTvia 774V VAT LAOR—JI) T 7 A )V% ASA & ORI TEEXETE &
4, HTTP. HTTPS. TFTP. FTP. E£7/-1XSMB ZfiH L T, ASA & DI TT 7 A L ZHEET
%i‘j‘o

G¥)

IPSSSP YV 7 "7 =7 D a— D4, IPS Y 7 7 =7 % disk0 12X 71— R4 AFIIC,
7T va AV EB50%DEENHD L EHER LTI, IPSEA A h—
NTHEEIZ, IPSOT 7 AN VAT LFIZNEE 7T v o ATV D S50% N TPRHINET,

A—AIPCETTSYIaABTD T 74 IILERE

ATy T

O—HNLPCL 7Ty a T AN ATLAEDBTT 7 A VEEEET HIZIZ, ROFIEELE
1ITLET,

FIE

AA L ASDM 7 7Y r—3 3 7 ¢ R T, [Tools] > [File Management] D JIFIZ5 R L %
ﬁ—o

[File Management] % 1 7 2 778 v 7 ANEKRIIVET,
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B /= rv—neossvramcorr M LER

AT 72 [File Transfer] DR{IZ3H D FREIZ 2 U >~ 7 L, #iV > T [Between Local PC and Flash] 27 U v 7

L\i‘g—c
[File Transfer] A4 7 2 7R v 7 ANKREINET,

ATYT3 B—ANLVPCELIET Ty va 77 ANV VAT LADELLNT, Ty rr—RELEFF Y

O—RL7ZWTZ 7 A NVEERIRL, BRIOETIZ KT v 7 LET, 0%, =—H/VPC £720%
7Ty a TrANV VAT IADELELNT, Tyya—REREFFvra—RLizWnWr 74
WEBER L, AREVEZIIERENZ 7Y v 7 L, HBEIOBANZ 7 7 A VERE L E9,

AT T4 BT L6 [Close] #7 VY w7 LET,

JE—FHB—NETSYTaARBTD I 74 ILERE

&

ATvT2

ATv73
ATvT4

VE— R P =R TF79 a0 T4 VAT AEDORITT 7 A )V EERET AI21X. ROFIE
FEITLET,

FIE

AA Y ASDM 77U r— a3 7 4 KT, [Tools] > [File Management] DJIRIZER L F

ﬁ‘o

[File Management] % 1A 7 2 77K v 7 ANERINET,

[File Transfer] kv v 7 # o U A NTFRA%ZZ U w7 L., [Between Remote Server and Flash]

Vv LET,

[File Transfer] ¥ A 72 7Ry 7 ARFRINET,

VE— k=I5 7 7 A NV EERET D21, [Remoteserver] 47> a a7V v 7 LET,

FRERIZIRD Y —A T 7 A NEERLET,

a) (FFvar) ASABRY—NELOBEIHERATAISN VX —T A ABHFEELET, 1
B —T oA AKRBELBZWES, ASAITEREHOV—T 4 7 T—TNEF =y L
FT, I TERRODORVGRIET X ON—T 4 T T =T N ETF v LE

—g‘o
b) V= NDIPT RLVARAZEDIZT 7 A NVOLGEHI~O/SAERINLET,

GE) 77 ANMEEIIIPVE BEIONIPV6 DT RLAZHAR— KL TWET,
¢) FTP OAITY ET— b y— DX A F %, HITP £7213 HTTPS DALY £ — k +—1
DR— EZEANLET, AR FIP A FIZRO L FBY T,
cap: Ny ET— RO ASCI 7 7 A )V
ean: Ny T EF— KD ASCI 7 7 A )V
vip: Ry T ET—RORALFY L A=Y T7 AL

sin: FNRX T BT—=RONRAL TV A A= T A )b
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ATvTh

ATvT6

ATy T17

ATvT8

ATvT9

ATv 710

ATvIN
ATvT12

ATvT13

JE—FH—nRET5vamcnTr LEE [

793 a Ty AN VAT LNE T 7 A NVEERET HITIE, [Flash filesystem] 47" = % i3

RLUET,

7 7 A INVDIGFT~D /R A% ANJ1T B0, [BrowseFlash| %7 U v 7 LTC7 7 A VOGBFTEEE

LET,

Fio, CLIKKELY, AFX— R T v T ar7 s Xal—rvar, Frar7sFal—rval,

FESMB 7 7 ANV VAT ANE T 7 AN E A =352 B TEET, Copy 2¥ 2 RO

FRAFHECONTIE, CLIay 7 4 Xalb—rar T4 REBRLTIES N,

Bk 57 7 A VD5 R EHRLET,

a) 77y va T AN TVAT LT 7 A INVEERET DHIZIE, [Flash file system] 472 3 &
WIRLET,

b) T 7 ANDEET DR E ANS)T D>, [BrowseFlash| 227 U v 7 LT7 7 A VOB & 45
ELET,

VE— b =27 7 AV EZHRET HITIE, [Remote server] 7 a V& EIR L9,

a) (FFvar) ASARY—NLDBEIENTLIA U F—T = A2tEELET, 1
B —T oA ABRELRWGE, ASAXEIHEAOV—T 4 7 T—TNEF v/ L
T, ZZCERAONLRWGERIET X DON—T 4T TNV ETF oy LE
7

b) 77 ANDBFA~DAREASLET,

c) FTPHEEDLAIIF A TEANNLET, A& A T I3ROLELY T,

sap : /Ny 7 E— KD ASCI 7 7 A )V
ean: Xy 7 EF— RO ASCI 7 7 A )V
cip: Ny T FT—RONRALF U A A=V Ty AV

sin: FN T FT—FRONRA TV S A= T7 A )L

[Transfer] Z#27 V v 7 LCT7 7 A MinikZBtG L £ 9,
[Enter Username and Password] % A 7 12 778 v 7 ANEKRIINET,

JE—h P—=ROa2—F4, RNZAT—K, FAASL (WBEREES) PNERENET,
[OK]Z7 Vw7 L, 77 A NMERKRZEHITLET,
T 7 A NMGET 0 AT D GERH Y £, LT TIT2ETEBRELIEEN,

77 AMIGENSE T LIS [Close] #7 Vv 7 LET,
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B ossacx—o asOM, B&URE—FFyT LT FaL—L 3 OBRE

ASA 4 A*—2  ASDM, BELURA— 7wy T 2T+«
XalL—oa>DEE

BELD ASA £T21ZASDM A A —U BB LHGEIE. 7— T DA A—VEBRETLHHLERDH D
FT, AA—VERELRWVERIIT 74V DT — A A—=UPMEF SN, FOA A=V
BERINTbOTERWAREER SV £3, AF— Ty ar74Fab—a Tk, =
V74 Falb—vary Iy ANVELETHEETEET,

WKDOT 74V FiREESRLTLEEN,
s ASA A A—T

cWIEEASA : NS 7 T v a2 AR UNTRODSTERYIDOT SV r—a s f A=
w7 —hLET,

« ASAv : FRANCIEBE L7z & ISR S iz, FiA Y B O boot:/ /3—T 1 a3 1T
bHA A=V HT—FLET,

* Firepower 4100/9300 > v —3/ £ ASA : FXOS v A7 A%, #EIT 25 ASA A A—
EFRELET, ZTOFIREFHLTASAA A—VERETDHILITTEERA,

* Firepower 2100 : FXOS ¥ A7 A%, ##19 % ASA/FXOS Ny 7r— T % RELET,
COFNEEFHLTASA A A=V EBRETDHZ LI TETEEA,

e TRTDASADASDM A A—Y : N7 T v a2 AT YNTRS»-7 (F21X2 20T

ARA—TUNBPNEESIE, A T7T v a AFUNTHRSNST) RO ASDM A A —
AT —hrLET,

CRA— P T T AT 4 FXalb—Talr T4 T, ASAIE. BL7 7 AL TH
BAE—F T v ar74Xal—rarhb7—hLET,

1R BRI

» Firepower 4100/9300 ¥ —3 : ASA 7 v 77 L— RIXFXOS IZ L » THEH SN ET,

ASAFARXL—FT 4 VT VAT LANTASA%R2T v 77 L—RTHZLILTEERA, LI
MNoT, ZOFNEE ASA A A—VITHH LN TL 72EW, ASA & FXOS 54127 v
TITVU—RTHIENTE, FXOST 4 L2 U URNMIBIZIZU A MEvET, ASA
Rl —=VIZITEIZ ASDM N E ENTWET,

* Firepower 2100 : ASA, ASDM, B X WNFX0S DA A —UIL 1 DO/ r—Z3 0 Kb

INTVWET, R r—VHEHITFXOS ICL > TEHINET, ASA AL —FT 47
VAT ANTASA%RT v 77— FRT5ZLIETEERA, LEBRST, ZOFIEE ASA
ARA—VIHHLZ2NWTL7ZEV, ASA & FXOS 2RI T v 7 7L —R$THZEI1ET
TFEHA, BNV RLENTHET,

« Firepower 2100 35 J (X Firepower 4100/9300 > ¥ — 3 @™ ASDM : ASDM [Z ASA A~ L —7F ¢
VT VAT ANINLT v T L= RT&E LD, N RV ETZ ASDM A A —T DI
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ATy T

ATy T2
ATvT3

ATvT4
ATy TH

ASA A A—. ASDM, B&EURE— TPy TavTq¥aL—varonz [

T AMLETIHY FHA, FEITTY v 72— K435 ASDM A A — T FXOS A A—
UZMIERINFERTA, ASADD ASDM A A —CHEHTALERH Y £,

N

G¥) FXOS TASANV RLVET w77 L—K+5E, FU4RI
(asdm.bin) TH D72, /N2 F/LND ASDM A A — )% ASA
EDRTD ASDM /N> RV A A—=VICE & HD Y 9, 72721,
7 w7 u—KLERIOASDM A A — (7= & %1% asdm-782.bin)
ZEBTERINT L. XRURALT v 77 L— R b5 &R T
AA—UNMERSNET, AHEDOSH H ASDM N—T 3 BT
LTWD I EEMERT HIZIE, N RVvET v 77 L— RT 500
\ZASDM %27 v 77 L— R4 250, FTIXASA RN RLET v
T L — RTAEBNC. Ny RS- ASDM A A —
(asdm.bin) Z T2 X 512 ASA ZHBRETLH2LENRH Y £
7

« ASAv : FIHIEBHD ASAv /Xy 71— Tld, ASA A A — VN5t H Y B boot:/ /3—T 4
avIlEESNET, ASAVEAT v L —FRTREEIE, 7T via AEVICHIOA
A—VHREELET, B Tar74Xal—ar®2 27358, ASAVIZTOREEO
AA=Th—RTHXIIR0DZ LIZERL TSV, FIHERED ASAV Ny r—
Wi, 7992 AR VICEHEEND ASDM A A=V HEFENTWET, ASDM A A —
CEBEMZT v T L— R TEET,

FIE

[Configuration] > [Device Management] > [System Image/Configuration] > [Boot
Image/Configuration] DJIEIZ N L F 5,

BENIA A=V LTHERTANA T A A=Y 77 AT, a—I b4 OFTHRETE
F9, ELTFTPH— DA A=V %1 DHEL, TINHLTNA A% T — N T&xE7, TFTP
=N SN TNDA A=V EIBETLH2HEIE. TOT7 7 A V%Y A NNOEFHICEE T
HMBERH Y ET, TNA AN, £ A=D1 — Red TFTP — N CEET X WA,
7T vva AEVIBEFEENTHDE Y A MNORDA A— 77 A DO — RPREITENE
7

[Boot Image/Configuration] ~X > T [Add] %7 U v 7 LE7,

T = TDHA A=V ESMLUET, TFTP A A — T DAL, [File Name] 7 « —/L KiZ TFTP
URLZANLET, [OK]ZZ Vv 27 LET,

L~BERZ L TABEIARY EZERHLTA A—VOIEELZT~FLET,

(A7 2 ) [Boot Configuration File Path] 7 4+ —/L" NG, [BrowseFlash]| %27 U v 7 L C=a v
TA4FX 2l —valERIRLTAY— Ny ar7 s ¥al—var 7y A VERELE
T, [OK] %227 Uv 7 LET,
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B - sar—vavtzrzonnrr L 08y s 7y THLUESR

AT w76 [ASDM ImageFilePath] 7 ¢ —/L K C, [BrowseFlash] %7 U v 7 L TA A — %K L CASDM
AA=VERELET, [OK] 227V v 7 LET,

ATy T [Applyl 227 U v 7 LET,

AV 74X Lb—2avFEREFEOMBOTI7AILDINY
9TF7vTEXIVIET
VAT DEENOGRHETHEOIIC, 3T 4 X2 L= aryBIXOEOMD T 7 A LD EHIH
RNy I T T EFITTHIEEHRLET,

[—] ~Q - NI “w O - = — [ B

SSEHEVATLNY I Ty TEEIFETDET
ROFIETIE, 2074 Xa2lb—varBROAN A=V D zip Ny 7T v 7 zip 7 7 A L~D
RNy 7T T7BLIONMETHEL, FOT77A4 00— 3L ' a—F ~OREHFIEIZHONT
FEAL £,

NV YTy TE-ETERIBT BHIIC

« Ny 7Ty TERIFTE L ERGT HENS, Ny 7T v S EIIECEITCER e T 4
A7 FEIA D7 &6 300 MB B AMLENH Y £,

cASAX, VN A TXARNE—RTHAILENDY T,

Ny Ty THREREFANA I T v TRIZA T 4 Fab—a VEER LGS, FOE
BNEEINy 7T v FZEZDoNETA, Ny I T v FOFATRIZZ T 4 Fal— g
VEBEFELTCOOETLEETLESS. Z0ary 7 4 Xal—ya b OER T EEX SN
FI, ERELT, ASAIRBRRLIFEFZTHZELH FT,

s IR TE DNy 7T v I EITE T 1 DT TT,

eV T 4 Xalb—a N KONy I T v T EFITLIEEEZ LFEL ASAN—T 3 T
DARETLTEET, HLY—EHHLT, ASADRLRLINN—Va U fTarT 4 Xa
L—2a w8735 LI TEERA, 274X ab—2a VOBITRLERGE,
ASAIE, FTLWASAOSZr— RLERICHEEET 5 A — Ty 7 a7 4F¥alb—va
CEHBMICT v 77— RKLET,

VTR T EERTAGE. N0 T v ERIIETLTEDLDX, AX— T v o
V74 FXal—vary, EfFar74Xal—rar, BIXOTAT YT 4T 4 EAED
HTT, 2=y T LWLy 7T v T EERB I OMETT 2HERH VY 97,

« T — L F—NR—5HHTHEE. Nyl T v TOERBIOMETIX, 77547 2=y
e AF NS, 2=y ML TR IZITOMNENH Y F9,
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CASAILVAX = NAT L —RXEFELTWDIHEAIL. COFIETER LNy 7T v
LT 4Kl — g DETHICE D AL — NRAT L—ANNE L 720 £9, ASA
DAL —=INAT L—=APRPARGEIE, v AX— AT L —AOFREESHL T, Ny
T P ERHATT DHNG, YAX— NATL—X%& Uty b5 HEZHBERLTLLES
AN

PKCSI12 7 —# %A > 7"— bk (erypto ca trustpoint =~ > RZfH) T 58I h T A MR
AV EIPRSA F—ZFHLTWDIELAE, A VAR —FSex— XTI T A MRA
MERUARINE Y LY TOENET, ZOHKOD, ASDMa> 7 4 X2 L— g &2
LB TR I A MRS PBLOZEDOXF— T ICHIOARTEEE LTZHE. AX—h
Ty FarZ 4 Xal—a i ar7 4 Xal—i g EREICICRLDIC, FTa
V74X 2=y a BRI RTAREGEND LIV ET, OFED, F—
X7 ERNTARRA  MIBIOARTZFEH L7ZEAIEX, toary7 4 Falb—va &8
TLTERNEWNS Z & T, ZOMEZERET 72D, FTARRA L MeEDF—T
WZII R CART A L T 7Za 0,

cCLIZHEHL TRy 77 v FLTHHASDMAZHFEH L TETLIZY . Z0OMA{T5 Z &1
TEFHA,

BN I T T Ty ANVICEHEENLLHNFITKRD L EBY TT,
cEf a7 4 F¥al—i gy
CAZ—R Ty a7 4Fal—gr
T RTOEX2VT 4 A A=Y
Cisco Secure Desktop 35 L UK A b XXy DA A—
Cisco Secure Desktop 33 LUV A b A% ¥ U DR IE
AnyConnect (SVC) 7 747 FDA A=V BLNT a7 7 AL
AnyConnect (SVC) DA AX~A ABIRENT VAT — 14

cTATUT AT AGHE (TAT T 47 4 iEAZEICEES T 572 RSA F— 7
ITEENDIN, AZ L RT7ay F— 3B Eans)

* VPN FHqidtA % —
*SSLVPN 27 4 Falb— g

+ Application Profile Custom Framework (APCF)
* Bookmarks

s WAL AE—T a3

XA FIv s TUEARY — (DAP)
cTTTA

BT m 7 7 ANVHOFERAT A VT

o« Fu X HENRRTE
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COFETIH., BEBRVAT IR I T v T HFITTBIFEICHOWVTEHLET,

FIE

AL a—F BT ANFEER L, Ny 2T v T T A NERFLET, 29754, &T
BT DHEXITRLT LR £,
[Tools] > [Backup Configurations] % Z&{R L £,

[Backup Configurations] % 4 7 12 77K v 7 ANFK/RSHVE T, [SSL VPN Configuration] fEIEK D T
KHZ27 V27 L, SSLVPN 2> 7 4 Xal—va DRy I T v 7 A7 ar wiRLE
T, TIHNETE, TR_COI T4 FXalb—YaryIZryAAnF=yrSh, FIFATES
BElInNy s Ty FENET, VA MNNOTRTOT7 7 A NVENNy 7T v 745121, FIA
SIS FET,

NPT o 7THar7oXab—rar 2T 55513, [Backup Alll F= v 7Ry 7 A

X 7ICLET,

NPT T THFTa ORRICHLT =y IRy I A AT LET,

[Browse Local to specify a directory and file name for the backup .zip file] #2 U v 27 LE 7,

[Select) ¥ A TR TRy 7 AT, WNo 2T v T 77 ANEEMNTHT 4 L7 MY EBERLET,

[Select] #7 U >~ 27 L¥79, [Backup File] 7 4 —/b RIZ/RANFKRINET,

TAVT M) RARDRIIN I T v 7T 77 A NOGEHOLHEANTILET, NI T w777

ANDEHORIIE, 3~232 LFORTHLILERH Y £7,

[Backup] #7 V v 7 LE9, GEHEEZ NNV 7T v 7T 554, ASA TYAHX— RAT L—

REMHLTWLGEEERE, TSIy 7T v PR ITSNNET,

ASA TV AL — NRATL—REHEL, A F—TNMILTWDIEE, Ny 7T v T Ekitd

DRENS, VAL —="AT L —=ANAHARGEITER T 5 2 L 2T 2EE A v —UNRFER

SINFET, YAFZ— RNAT VL —AND0ro TWAEEAEIE, Yes] 27 Vv 7 LT AR I T v

ZRHATLET, IDFEAEEZ Ny 77 v 7T 58 5RE, 7SIy I T vy IREITINE

7

IDAEAEE Ny 77 v 7T 5861%, fEHFELZ PKCS12 BTy a—7 1 v 735791

T 2RORAT7 =X AT HEICRDONET, "ATVL—XE AT DHH, Fiz

LZDOFEEAX Y TTHENTEET,

() Zo7ebATDRRAEFREIANAY 77 v 7 INETR, BREROERAFI ANy 77T v
TEINEFA, CATREHED NNy 77 v FFIAICONWTIEL, 2=/ CAY—/3D 3y
77 w7 24X—=2) BRLTIIESN,
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ATvT12

ATvT13

Ny 7y ITDER .

AEFAEA K53 521X, [Certificate Passphrase] % 1 7 1 7' 7R w7 A CREBHED /(A7 L—
R ANNBIOWEGE L, [OK] 227 VU v 7 LET, iEAEOETRHIMNEL 25720, =
DEATATRY 7 R AT LI NAT— FE2RZ TELLERH Y £,

s[Cancel] Z#7 U v 735 &, ZOFIENAX Y T Eh, sEHETINv 7T v 7 SNER A,
[OK] £7zlX [Cancel] 27 VU v 7§25 L, T <ITRy I T7 v 70 ENET,

Ny P T oTMETTDHE, AT—F AT 1 FUMNREAT, [Backup Statistics] 4 7 1 77K >
I AINETR S, BRIIETLTREDO A v =V P IRENET,

GE) RN T7v70 TR Avv— %L DA, IBESNT-ZA TOEFEOa
TA4FX2b—va ryPNHEELRWEARICERRINET,

[OK] %7 U w7 L. [Backup Statistics] ¥ 72 7R 7 A% L ET,

N7y TDET

ATv T
ATy T2

ATvT3

ATvT4
ATy TH

ATvT6

ziptargz 7 7 A A B0 =V PCICETT A 7 4 Xal—a o A=V ERELE
ﬁ—o

FIE

[Tools] > [Restore Configurations] % S8R L £ 97,

[Restore Configurations] %' 7 7 778 v 77 AC, [Browse Local Directory] 7 UV v 7 L, B—%
N arva—4 LD, HrxThar7 4 Xalb—rarNEEN 05 zip 7 7 A VEER
L. [Select] #7 V v 7 LE£9, [Local File] 7 4 —/L RIZ/NA & zip 7 7 A VADBERRIINLE
D

35 zip 7 7 A /Vi%. [Tools] > [Backup Configurations] 4= 7°v 2 > &R L TEK L7ZH D
THLILENHY FT,

Next]#7 Vv 27 LEF, 2-2HD [Restore Configuration] ¥4 7 2 7R v 7 ARERINET,
BT 5a 74X al—2arORIChdbFov IRy 7 A5 F AT LET, FHARERT
RTHOSSLVPN 2 7 4 FXFal—2a v BFE 740 b TEREIENTHET,
[Restore] #27 U » 7 LET,
Ny I T T 7 A NVOLERRRFIC, GEHEOK SLICHE AT 25 ENSA 7 L— X2 E L T
WOHSGEIE, ZONRATL—X% AT 5L D12 ASDM M H3RO HiLE T,
FEIFAr T 4 F¥al—va Y OETERRLEEA, #7374 Falb—variiaTs
M, FATar 74 Xalb—rarEEBETLN, FREFECT e A IOy E AT v T
LHink=mhbhEd,
e LT 4 F 2l —a VORE TR, BEDFETa T 4 X2l —a b RNy TS
ENEETFay 74X —TarBdESEnET,
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. H—AILCAY—RDNNy Ty T

e FITa L T 4K al—ra VOEHBTIE, Nyl T v T ENEETaryr 7 ¥ al—T g

VORBMERINET,
c ZOFEEAX Y TTEHE, NI T v T ENEF Tar7 4 Falb—va L IETEh
FHA,

ASDM TlX, HETTEMENE T THAETAT —Z A XA TRy J ARERINET,
AT Effar 74X ab—ra  EAERELITES LESEAIE. ASDM 2L T b Hild L E

T, EfTar 74Xl —2a 2 BT Lo 85E81%. ASDME vy a2V 7L via
LT, BHEEHMZLET,

W~ W~ O
O—AJCAY—/\DI/INV DT v
ASDM Nw 77 v 72 RITLIZHE. v— 0V CAY—R T —=FR=2IEGFEN TR\

W, =" EDCAGFHEIIRY I T v 7ENERHAL, B—HIVCAV—RNERy I T v 7T
HEAIEL. ASACLLIC L AROFEF Yt 22 L ET,

FIE

AT w71 show run crypto caserver 2~ K& AN LE T,

crypto ca server

keysize server 2048

subject-name-default OU=aa,0=Cisco, ST=ca,
issuer-name CN=xxx,0U=yyy,0=Cisco,L=Bxb, St=Mass
smtp from-address abcd@cisco.com

publish-crl inside 80

publish-crl outside 80

ATw T2 eryptocaimport 2~ RZEH LT, m—H/LCAPKCSI2 77 A V&AL AR —hKhLT
LOCAL-CA-SERVER KT A haRA v F&EERR L., F—_T Z2E T LET,

crypto ca import LOCAL-CA-SERVER pkcsl2 <passphrase> (paste the pkcsl2
base64 data here)

GE) ZOFNETIL, EMER4RT TLOCAL-CA-SERVER] Z 4L FEHA L T,

AT 73 LOCAL-CA-SERVER 7 « L' 7 kU BMFE L7254, mkdir LOCAL-CA-SERVER % A7) L
THERT AV E R H Y 97,

RATv T84 v—H)VCA 77 A% LOCAL-CA-SERVER 7 4 L7 RV icat—L %7,

copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.ser
disk0:/LOCAL-CA-SERVER/

copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.cdb
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diskO:/LOCAL-CA-SERVER/

copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.udb
disk0O:/LOCAL-CA-SERVER/

copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.crl
disk0:/LOCAL-CA-SERVER/

copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.pl2

diskO:/LOCAL-CA-SERVER/

RATv 75 cryptocaserver 2~ K& AN LT, ="/ CAV— Rl FX—TMIZLET,

crypto ca server
no shutdown

AT 76 show cryptocaserver 2~ REZ A LT, a—H /L CAV—"PNEEHL, BfELTNDHZ &
AR LET,
RAT9TT1 REERGFLET,

TFIP H—/I\~ADEFTaA T4 ¥ L— 3 DRE
TOMRERIZEY . BIEEOFETa Ly 7 4 X2 — gy T A NADa—% TFTP % — \CRTE
LEd,

FIE

AT 71 [File] > [Save Running Configuration to TFTP Server] % &R L 9,
[Save Running Configuration to TFTP Server] % 4 7 2 77K > 7 ANRRIINET,

ATYFT2 TFTPH—"DIPT KL AL, a7 4 Xalb— gy 77 A VORITFNEE 72 % TFTP H—
D77 A0 2% AJJ LT, [Save Configuration] #7 U v 7 LE7,

GE) 774/ O TFTP & E%1T 9 121X, [Configuration] > [Device Management] >
[Management Access]> [File Access]>[TFTP Client] DIFAIZEHR L 7, ZOREEIT-
L, ZoFA TR IRy 7 AL, TFTP H—"D P 7 KL A & TFTP —/3 kT
DT 7 ANV NABABCRSRINET,

VAT LBEEORTS1—)L

System Reload > —/LIZ KV | VAT AOHETZ AV 2—L LY BUEOHEEZ ¥ v
ENLTEY TEET,

YIrwz7ssUavIqFaL—var |



YIrYITELVIYTaFaL—2ar |
. Auto Update D% E

FIE

AT 71 [Tools] > [System Reload] %R L £,
AT v 72 [Reload Scheduling] fHIK T, WROXEL EHE L £,

a) [Configuration State] TlE, FHEEIRFIZFE T2 7 4 X2 b— 3 UERFET D0, T
LHMDELBNEEIRL T,

b) [Reload Start Time] Ti&, IROA 7> a I HFIRL E7,
s BB Z 7272 BICFATT DT, [Now] 227 U v LET,

« FRE LICWRI7Z 0 BE# 28 58 51203, [Delaybyl 27 V v 27 L7, BEEBLM
ETORHZ, KH & DHEAL, £ESENLZT TANLET,

« FEE L72WGZ & BAHCHRENZ EITT DL IR Y2 —/bF 5121, [Schedule at]
7V LET, BEBIOETRHAEZ AL, BEEBIORAT Y 2 —/VHZBRIRL £
‘j‘o

c) [ReloadMessage] 7 « —/V RiZ, FFEENRFIZBAVCTUVWD ASDM A A X AZEET DA
=Y EANILET,

d) HEENE FFITT 2 E TORKBRR Z K & 2 HAL T, EIIm A ET TERRT DI
IZ. [On reload failure force immediate reload after] = v 7 AR v 7 A% A NI LET,

e) REWHE- THEENZ A7 Y 2 —/L 3 5HITI1%, [Schedule Reload] %7 V v 7 LE T,

[Reload Status] fEkIZ 1L, FFEEIDO AT — & ANFRINET,
ATV T3 WOWTNNERIRLET,
« ATV a—)L SN HEE A Z1ET 512, [Cancel Reload] #7 U v 27 LET,

o« AV 2 — )L INT-HEEIORK T IZ [Reload Status] Fork & U 7 Ly 24 51203, [Refresh]
27 Vw7 LET,

¢ ATV a— )L ST HEBIOFEMAZ R R T 511X, [Details] 27 V v 27 LET,

Auto Update D% 5E

Auto Update (%, AutoUpdate hr— P32 7 4 Fal—2alBIWNY T N =T A A—T%
ZEDOASAIZT T — N5 L Z2FFA L, TRNED ASA DEANpT=2 ) > 7 &t
3257 b2 AR CcT,

Auto Update [C DLV T

Z OIATIX, Auto Update ?F2E 574 & Auto Update 234 BT 72 HERHIZ DWW TR L £,
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Auto Update 7 51 7 > b E iz —5 [l

Auto Update 7 5 1 7 > hE I H—/N

ASAIVL, 7747 FERIFTY— L L TRETEE T, AutoUpdate 7 7 A 7~ & L TH)
ET 28561, Y7 Uo7 A A—VBIPary 74 Xal—vary 7y AN~DT v 7T —
D728, Auto Update r— N2 EHIHIZAR—Y 7 LE7, Auto Update H— & L TEIES
H8%60%. AutoUpdate 7 74 7 e L TERESNTZASA DT v 77— M ERITLET,

Auto Update O Fi| s

Auto Update I, kD X 912, BELE S ASA OEHCHEE T 5 S F S EMBEZ LT 5
Fl7epkre T4,
cHAFI I T Ry 7B I ONAT (2B 5 [BIRE R O,
AT 4 X2 L= arOERE 1 OOT 7 aryTaly b,
« V7 MU =T EHAOEEE ORI ORI,
A TRA TV T A FAOF5FEEDH 52 HAOTER (7 =—F—"—)
cF =T AU —T A AT K DRI DR,

e —bE R TS A—BREOEX2VT 4 V) a—T 3 rOfHEL,

AutoUpdate fEERIE, o, E3EEOBEHNL, VE— MNEFHT FU r— 3 12k ) ASA
@2V74¥JV—VaV%y7bvl74x VhFYa— RUY | HRIREGRE
ERITLIZV T DEAICHERA T TARNT 7 F ¥ TT,

Auto Update fIARIZHE D & AutoUpdate — 3B ASAIC > 7 4 X ab—a UERE T v
Talleh, EREFELTHEHREZIIG LD 252 L 6. ASA 725 Auto Update H— /NI 7E
HHNZAR =Y 7352 L8> T, &HDOary74Xab—ra UEREGIEHT (T
%.’)) b TEET, 72, AutoUpdate h— N[ IWOTH ASAICa~ > REXREL, 2726
IR—V U THEREFMESEDLZ LB TEET, Auto Update — & ASA O3 TlE, #B(E
/\X}:El ANVCLL Ay 7 4 X2l —ra T _XTOASAICRET HHERH D T,

7 T — LA —/N\—E&E TO Auto Update H—/\ H7R—

Auto Update ' —NZHEHA LT, Y7 =T A A—Vbar74F¥al—vary 77/
B, TITATIAZ N, To— LA —N— 2T Falb—aDASAICHETEE
T TIT A TIAZ N, T 2—)bF—"—2a7 ¥ a2 L—1 3 TAutoUpdate & 1 1 —
TZT DL, 72— A== XT DT T A~V 4EEIZ Auto Update h— "D a7 ¢
Fal—Tary2ANILET,

T x— )V A—R— a7 4 F 2 bL— 3 O Auto Update Vr—N YR — MZid, ROHIFR & B
EEMH vk,

T ITFATIAR NN, A T 4 X2l —a B R—FENLHDIT, V7V E—F
VPSR

CHLWT Ty b7+ —L VT MU =T A A—VH2u— T 58 72— A—— 7
X774y 7 OREEIELLET,
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B Avoupdate 7oz omE

¢ LAN X—AD T = — VA —N—%fHlT2HE, HiLnary7 4 Xal—vgi42ko
Tz NF ==Y o rPar 74 Xzl —TarPNERINTUIWVTERA, 72—
NF—NR— Yo r7Dary 7 4 Xalb—arPNERINA L, EEEOBEIZRRLE
j_o

* Auto Update H—/3~ Call Home % F{73 2 DIT 77 A ~ V) #i& 7217 T¥, Call Home %
FATTDINE, TIA~VEERT 77 4 7RETHLILERH Y £3, £ 5 TRV
AL ASAITHBIIC T A ~ VHEREICT = — LA ——LET,

VT NI 2T AA—VEFIF I T4 X2 —ar TN EE T a— RTADIX
FISA VBT TT, FO%, VI NIz T ARA—VFER T2y 7 4 X2l — gy
TrANMTeh XV EEICa—SNET,

e AL HB—T A AMACT RLAEN—FRT 27DV TNLNEET. 754~ VEBDL
DTI,

* AutoUpdate ' —/NE 72T HTTP — NIZRfF SNz 7 4 Fab—a v 7 7 A )V
T4~ VEEEHTT,

Auto Update 7O X DIPE

WIS, 72— vA—/"— a7 4 F a2l —3 3 TO Auto Update 7' 02 & ADOE A /R L E
T, ZOTaBRE, Tz A== RA =T N THY, BIEL TSI EE2RiIfEE LT
WET, EEN T 4 Fab—a rERPEL TWH5EE. SSM I — FORES LISt OB
TR NABEBEIREENBEL TWDIGE, £72id, 7Jo—nAFd ==V IRFxT L
TWAH YA, Auto Update 7' R FFEITTEXEHA,

1. MAFOEEIL, 7T F 74 —LBLOPASDM V7 "o =27 Fov 7P L= g0
THHRE WL ET,

2. T4 = VEEET Auto Update — 2T 7B A LET, TIA < VEEBNRT 7T 0 74K
RETRWGE, ASA X7 74~ VEEEIZT = — LA —/3— L7=%. Auto Update —3|Z
TIEALET,

3. AutoUpdate — %, Y7 U =7 F=zv 7% AL URLIERZELET,

4., TIA=VEED, TIT AT ERIZIRAZ NN EEDT T KT —Ab A A=V T 7
ANET v 7T — R T HLERDD EHE L2GE1E, IROWMBENEITINET,

1. 77 A~ V%EEIL, Auto Update %—~ D URL Zfi ] LT, HTTP ¥ — 305t 7q
T ANVERRFLET,

2. TIASVEEIT, FOAA—TVERAFUNSEBIZaE—-LT0L, HEHDOA A—
CET v 7T —bhLET,

3. MFTOBEBEBIZH LA A—=URNH5881T, B F Y (REZ 8 () EENEIIC

UE—Féﬂi¢o
BN FVEBOT — MREIZE y NLA T v 77 L— R3ARERGEIX, B v
B UIENT 7T 4 TEHEIZRY, TIA~VEER ) —FEnEd, Ju—

RPETT DL, TIA~VIEENRT 7T 4 7THEITRD 7,
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5.

6.

Auto Update DH A K541 > .

e AR UNRAHEBDOT — MFICE Y LA T w77 L— RRTEX WAL, Wh
DOIEENFRFZY m— RavE T,

THUHY (RE L) BEERPFICEHE LW, A—=005850, o2 ) EiE
FonVe—RNEnET, T4~ VEBEIL B X VEBREO) a— KBRKETT5H
FCREL E T,

TIA=Y (T T747) HBEFLTICH LA A—=—UNHA5581L. B FUEE
MNT 7T 4 THEBIZRY, TIA4~<VEER)o— FINFET,

LI —ET ST — N e AREIE 1 LB INET,

ASAN, T4~V FEFT D ZFVEED ASDM 7 7 A NVET v 75— M9 50N
HD LA LI=GE 1, ROWMBENREITINET,

1.

2.

3.

4.

7T A~ VAEEIT, AutoUpdate B— 372 42 S 4172 URL 2464 LT, HTTP % —
25 ASDM A A —Y 77 A VERHE L ET,

TIA<VEEL, VEISLTEFOAS A=V EBEAA AL EBEIZaE—LET,
TIA< VBT, BEDASDM A A—C %27 v 75— M LET,
LY —FET ST — N e ARNEIA 1 SLERBENET,

TIA~ VBN, a7 4 Xal—var I rANET v I T TOLERDHD EH
W L7235 A1, ROMBERETSINET,

1.

3.

TIA < VEREIF, BESNZURL ZEHLT, bary 7 Fal—ar 77
ANERIFLET,

W OB TR, HFVnar 7 Xalb—TarBHlnar 7 X2l —T gy
ICEBRSLET,

HO)—ET v FTF— K T ARFIE 1 NLEBINET,

Fx v I VIR TRTOAA—UBIRa Ly 74 Fal—rary 7740 E—HLTNAS
WE. Ty —NIVEHYVERTA, 2O T, ROKR—Y v 7 E cHlr S
ﬂi‘g—o

Auto Update D HA K54 >

AVTHFERANE—F
Auto Update (%X, > 7V a2 7F AN E— RTORAYER—NEINET,

AP
7AYo TE Y AR— SN EREA

YIrwz7ssUavIqFaL—var |
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. Auto Update 4—/\ & DEIEDERTE

ETIL

WROET LTI R— NS EHA,
* ASA 5506-X, 5508-X, 5516-X
» Firepower 2100, 4100, 35X V9300
* ASAv

ZOMDHA K514

« Auto Update b — 3205 ASA D7 4 Fa b — g UNEHFRENTEH., ASDM (ZIHi@A!
SN FEH A, [Refresh] F 7213 [File] > [RefreshASDM with the Running Configuration on the
Device] ZIBIR LT, IO 7 4 Fab—a L E2RGTIXERHY £, F7-.
ASDM CTa v 7 4 X al—3 g VIMATEERITRDbNET,

« Auto Update Hh— N LIl 272007 v h 2L & LTHTTPS BRI TV DAL,
ASA X SSL ZfFH LE 4., Z#E. ASAIZ L % DES 7213 3DES 7 A & v ZADEAE D
%E:/C:“@Ao

Auto Update H—/\E DBIEDETE

FIE

AT 71 [Configuration] > [Device Management] > [System Image/Configuration] > [Auto Update] % i

WLET,
[Auto Update] 21 > {Zi%. [Auto Update Servers] 7 — 7 /L DLIZ [Timeout] ik & [Polling] fElEk
NV ET,

[Auto Update Servers] 7—=7/L"C, Auto Update — N TITEEHE SN TWDH/XNT A — X &
RTEET, ASA X, T—TNO—FLIZHDLIV—"EHRANIAR—Y 7 LET,

ATV T2 T—=TNHNOYV—"DOIEF%2EE S 521, [Move Up] £721% [Move Down] 7 U v 7 L%
7

[Auto Update Servers] 7 — 7 JWZIZIRD B 7 LR H D £,
« [Server] : Auto Update Y — SO FTE /21X IP 7 KL A,
« [User Name] : Auto Update % — D7 7 & AW S 52— ¥4,
* [Interface] : Auto Update H— " ~DEREFFERFIHEH I NDA L F—T = A A,

* [Verify Certificate] : Auto Update H— 373K L 7-GEH]E %, ASA TCA O/L— FEE & iR
AL TCHERRT 2008 90 &RELET, Auto Update H—/ 3 LTV ASA 1Z[A U CA %
TOULENDY £,
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ATvT3

ATvT4

ATy TH

ATvT6

Auto Update 4-—/\& DBEIEDERTE .

[Auto Update Server] 7— 7 /L DITOWTInE X 77 U v 7325 L [Edit Auto Update Server]
AT a TRy 7 ZANBE, Auto Update h— 30D/ T XA —X AR CTEE£4, ZZTiroiz
EEI-EHICT—7 VM ENETHN, 207 4 F 2 b—3 a3 VITRFET 51213 [Apply]
7V T HMERDHY T,

[Timeout] = U 7 TiX, ASA 2% Auto Update h—/SD X A4 AT U N ORI 2R ETE ET,
[Timeout] fFEIEIZIZIKRD 7 4 —/L RBH D F7°,

* [Enable Timeout Period] : ASA 7% Auto Update Y— 3 LIGE 55 Lo 1258104 A
AT T MTAITE. At LET,

* [Timeout Period (Minutes)] : Auto Update —/ 35 JSE N 720> 723550 ASA DX A LT
7 NREE (L) AFRELET

[Polling] =V 7 T, ASA /5 AutoUpdate — _"DIFEREZR—VU /T HHEAHETE £,
[Polling] fEIRIZ XKD 7 4 —/L R3H Y 97,

« [Polling Period (minutes)] : ASA 7> Auto Update +— MZH LWVMEREZR—V 745 &
EORFHERFHE (S HAL)

* [Poll on Specified Days] : I"N—VU > 7 DA V2 —VERELET,

* [Set Polling Schedule] : [Set Polling Schedule] %4 7 & 77K v 7 ANFK/R S 41, Auto Update
=N R—=V 7T 5 A LA ERETE T,

s [Retry Period (minutes)] : —/ DR —V 7R L7256, ASA 2>5 Auto Update H—
NIZHLWEHRE R —Y 7T 5 F TOFRFORER] (AL

* [Retry Count] : ASA 7>5 Auto Update H— N8 LUWME#E R —Y > 795 &L & OFFIT
[EiE~&

A=V T AT a—)VOHKRE

[Set Polling Schedule] %4 7 & 778 v 77 A Tl&, ASA 75 Auto Update h— %2R —VY > 74 %
FED B LR ZHRETEET,

[Set Polling Schedule] %A 7 & 77K v 7 ZZIFIRD T 4 —/LV KRB £,

[Days of the Week] : ASA 75 Auto Update — "2 R—V VT HBHDOF = v IRy 7 A%
HERLET,

[Daily Update] ~24 > 7 /L —=7"Cl¥, ASA 7% Auto Update % — 3% R — U > 7§ 25 BEL & 3% &
TEET, ROT 4=V ERHY £,

» [Start Time] : Auto Update DA — Y > VBALGEIEZ 2 A ) L £,

* [Enable randomization] : ASA 7>% Auto Update — 3% 7 > &% L &ER L 72BN AR — U
YT BITIE, AT LET,
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. Auto Update DE=% ') >4

Auto Update D E=4% 1) >4

Auto Update 7Ot RDE=Z2 1 Y5

debug auto-update client ¥ 7213 debug fover cmd-exe =~ > RZ{#H L T, Auto Update 7' =&
ATHEITSNDUELZFR/RTEZ E£J, RIZ, debug auto-update client =~ > KD H 15|z 7~ L
£9, debug¥ —IF oy arnbavry REETLET,

Auto-update client: Sent DeviceDetails to /cgi-bin/dda.pl of server 192.168.0.21
Auto-update client: Processing UpdateInfo from server 192.168.0.21
Component: asdm, URL: http://192.168.0.21/asdm.bint, checksum:
0x94bced0261cc992ae710faf8d244c£32
Component: config, URL: http://192.168.0.21/config-rms.xml, checksum:
0x67358553572688a805a155a£312f6898
Component: image, URL: http://192.168.0.21/cdisk73.bin, checksum:
0x6d091b43ce96243e29a62£2330139419
Auto-update client: need to update img, act: yes, stby yes
name
ciscoasa(config)# Auto-update client: update img on stby unit...

auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1, len = 1024

auto-update: Fover copyfile, seq = 4 type = 1, pseq = 501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 2001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 2501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 3001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 3501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 4001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 4501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 5001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 5501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 6001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 6501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 7001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 7501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 8001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 8501, len = 1024

auto-update: Fover copyfile, seq = 4 type = 1, pseq = 9001, len = 1024
auto-update: Fover file copy waiting at clock tick 6129280

fover parse: Rcvd file copy ack, ret = 0, seq = 4

auto-update: Fover filecopy returns value: 0 at clock tick 6150260, upd time 145980 msecs
Auto-update client: update img on active unit...

fover parse: Rcvd image info from mate

auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
Beginning configuration replication: Sending to mate.

auto-update: HA safe reload: reload active waiting with mate state: 50
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auto-update: HA safe reload: reload active waiting with mate state: 50
auto-update: HA safe reload: reload active waiting with mate state: 80

Sauto-update: HA safe reload: reload active unit at clock tick: 6266860
Auto-update client: Succeeded: Image, version: 0x6d091b43ce96243e29a62£2330139419

Auto Update 7' 1 & 23RS 5 & IRD syslog A v B —VBRAERINET,

$ASA4-612002: Auto Update failed: file version: version reason: reason

file X, KR LT7=T v 77— MM LT “image”, “asdm”, F721% “configuration” (272 V) 97,
version l&, 7 v 7T —hDNR—=T g L FEFTT, reasonld. 7 v 7T — FHPRELIZFET
ﬁqo

YIbrDxz7EQVTAaFXFaAL—PaVDER

A DA
T4—L4L1)
HERER )—X HEREIE R
X7 art— 773447k 9.1(5)/9.2(1) SCPH—REDMTT 7 A N AEHEET H7-5. ASA 1T

SecureCopy (SCP) 7 7A4 7 > haHhHR—rTDHLHIC
0 FE LT,

ROBHENPELSLE LT,

[Tools] > [File Management] > [File Transfer] > [Between
Remote Server and Flash] [Configuration] > [Device
Management] > [Management Access] > [File Access] >
[Secure Copy (SCP) Server]

AXE AIRE7: SSH WE BHaE L AT L) | 1(DOAGPIBOAD) | . — 1% SSH s H{b A F BT 2 & T 5fbE— F%

LN

BIRL, SEIERF—EWT L TY XAITH LT
HMAC ¢ b aRETCE LT, 77U r—a i
JET T, BEOMEZRS L7z T2 0LERH 555
AENHVET, BEXaT Rab—0/7 p—~ 2 AT
LT T AW LES, T 74V BT,
ASA [ 3des-cbe aes128-cbe aes192-cbe aes256-cbe aes128-ctr
aes192-ctraes256-ctr DNEIZ T /LT Y X L% Rr T T— |
LET, RENZRYOT VT XL (3des-cbe) 73
BRI NG, aesl28-cbe 72 & D — N /27 L 2
URXAPNEIRENTGAE LD L RIBIZ N7 4+ —< AR
KFLET, & rasnicis R EE TS
{Z1Z., ssh cipher encryption custom aes128-cbe % i ff L
ESc AN

WO E 2N EA X LE L7, [Configuration] > [Device
Management] > [Advanced] > [SSH Ciphers]
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WARNING: The certificate provided by the
auto-update servers will not be verified.
In order to verify this certificate please
use the verify-certificate option.

ﬁﬁ%%ﬁ?é%@ﬁ\ﬁwio TR L A BIRIIC
Fl /,_:.E_’L/i?o

RO mEPAATE S4E LTz, [Configuration] > [Device
Management] > [System/Image Configuration] > [Auto Update]
> [Add Auto Update Server],
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